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1 Product introduction

● Product comparison

● Product views

● Finishing accessory views

● Product hardware setup and software installation

For more information:

In the US, go to www.hp.com/support/ljM806.

Outside the US, go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Product comparison

  

M806dn

CZ244A

M806x+

CZ245A

Paper handling Tray 1 (100-sheet capacity)

 Tray 2 and Tray 3 (500-sheet capacity each)

 Tray 4 and Tray 5 (combined 3,500-sheet capacity)  

 Automatic duplex printing

 500-sheet output bin

Connectivity 10/100/1000 Ethernet LAN connection with IPv4 and 
IPv6

 Easy-access USB port for printing without a computer 
and upgrading the firmware

 Wireless direct accessory for “touch” printing from 
mobile devices (optional on some printers)

 

Storage HP High-Performance Secure Hard Disk  

Control-panel display and input Touchscreen control panel

Print Prints 55 pages per minute (ppm) on A4 and Letter-
size paper

 Easy-access USB printing (no computer required)

 Wireless direct accessory for “touch” printing from 
mobile devices (optional on some printers)

 

 Mobile printing using the following:

● HP ePrint

● HP ePrint software1

● HP ePrint Enterprise

● HP ePrint Home & Biz

● HP Printer Control

● Google Cloud Print

● AirPrint

Supported operating systems23 Windows XP SP2 or later, 32-bit and 64-bit

NOTE: The software installer does not support the 
64-bit version, but the print driver supports it.

NOTE: Microsoft retired mainstream support for 
Windows XP in April 2009. HP will continue to provide 
best-effort support for the discontinued XP operating 
system.
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M806dn

CZ244A

M806x+

CZ245A

 Windows Vista, 32-bit and 64-bit

NOTE: Windows Vista Starter is not supported by 
the software installer or the print driver.

 Windows 7, 32-bit and 64-bit

 Windows 8, 32-bit and 64-bit

NOTE: UPD PCL 5 is not supported for Windows 8.

 Windows 2003 Server SP1 or later, 32-bit and 64-bit

NOTE: The software installer does not support the 
64-bit version, but the print driver supports it.

NOTE: Microsoft retired mainstream support for 
Windows Server 2003 in July 2010. HP will continue 
to provide best-effort support for the discontinued 
Server 2003 operating system.

 Windows Server 2008, 32-bit and 64-bit

 Windows Server 2008 R2, 64-bit

 Windows Server 2012, 64-bit

NOTE: UPD PCL 5 is not supported for Windows 
Server 2012.

 Mac OS X 10.6, 10.7 Lion, and 10.8 Mountain Lion

1 The HP ePrint Software supports the following operating systems: Windows® XP SP2 or greater (32-bit) up to ePrint Software version 3; 
Windows Vista® (32-bit and 64-bit); Windows 7 (32-bit and 64-bit); Windows 8 (32-bit and 64-bit); and Mac OS X versions 10.6, 10.7 
Lion, and 10.8 Mountain Lion.

2 The list of supported operating systems applies to the Windows PCL 6, UPD PCL 6, UPD PCL 5, UPD PS, and Mac print drivers and to the 
in-box software installation CD. For a current list of supported operating systems, go to www.hp.com/support/ljM806 for HP's all-
inclusive help for your product. If you are located outside the US, go to www.hp.com/support, select a country/region, click Product 
Support & Troubleshooting, enter the product name, and then select Search.

3 The HP Software Installer CD for Windows and Mac installs the HP PCL 6 discrete driver and .NET 3.5 SP1 for Windows operating systems, 
the .NET 4.0 for Windows 8 and Windows Server 2012, and the Mac driver and Mac Utility for the Mac operating systems. Other optional 
software is also included on the installation CD.

ENWW Product comparison 3

http://www.hp.com/support/ljM806
http://www.hp.com/support


Product views
● Product front view

● Product back view

● Interface ports

● Control-panel view

Product front view

1 2 3 4

5

6

7
8

13
12
11
10
9

14

1 Hardware integration pocket (for connecting accessory and third-party devices)

2 Control panel with color touchscreen display (tilts up for easier viewing)

3 Top output bin

4 Easy-access USB port (for printing without a computer)

NOTE: An administrator must enable this port before use. See Print from the USB port on page 56.

5 Tray 1

6 Right-side door (access for clearing jams)

7 Lower-right door (access for clearing jams)

8 Tray 4

9 Tray 5

10 Tray 3

11 Tray 2

12 On/off button
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13 Front door (access to the toner cartridge)

14 Straight-through output bin
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Product back view

1

2

3

5
4

1 Left door (access to the fuser and the duplexer)

2 Power connection

3 Connection for an optional finishing accessory

4 Model and serial number label

5 Formatter (contains the interface ports)
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Interface ports

1
2
3
4

1 USB port for connecting external USB devices (this port might be covered)

2 Hi-Speed USB 2.0 printing port

NOTE: For Easy-access USB printing, use the USB port near the control panel.

3 Local area network (LAN) Ethernet (RJ-45) network port

4 Foreign interface harness (for connecting third-party devices)
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Control-panel view
The Home screen provides access to the product features and indicates the current status of the product.

You can return to the Home screen at any time by touching the Home button on the left side of the product 
control panel. You can also touch the Home button in the upper-left corner of most screens.

NOTE: HP regularly updates features that are available in the product firmware. To take advantage of the most 
current features, update the product firmware. To download the most recent firmware update file, go to 
www.hp.com/support/ljM806 for HP's all-inclusive help for your product. If you are located outside the US, go to 
www.hp.com/support, select a country/region, click Product Support & Troubleshooting, enter the product 
name, and then select Search.

NOTE: The features that appear on the Home screen can vary, depending on the product configuration.

1 2 3 4 5 6 7 8

9
10

11
12

1 HP logo or Home button On any screen other than the Home screen, the HP logo changes to a Home  button. Touch the 
Home  button to return to the Home screen.

2 Stop button Touch the Stop button to pause the current job. The Job Status screen opens, and then you can cancel 
or continue the job.

3 Sign In or Sign Out button Touch the Sign In button to access secured features.

Touch the Sign Out button to sign out of the product if you have signed in for access to secured 
features. After you sign out, the product restores all options to the default settings.

4 Product status The status line provides information about the overall product status.

5 Language Selection 
button

Touch the Language Selection button to select the language for the control-panel display.

6 Sleep button Touch the Sleep button to put the product into Sleep mode.

7 Network button Touch the Network button to find information about the network connection.

8 Help button Touch the Help button to open the embedded help system.

9 Scroll bar Touch the up or down arrows on the scroll bar to see the complete list of available features.
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10 Features Depending on the product configuration, the features that appear in this area can include any of the 
following items:

● Quick Sets

● Retrieve from USB

● Retrieve from Device Memory

● Job Status

● Supplies

● Trays

● Administration

● Device Maintenance

11 Home button and light Touch to return to the product Home screen at any time.

12 Refresh button Touch the Refresh button to clear changes and restore the default settings.
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Finishing accessory views
● Stapler/stacker

● Stapler/stacker with hole punch

● Booklet maker

Stapler/stacker

2 3 4 5

1

6

7
1 Stapler/stacker output bins

2 Stapler/stacker output slot

3 Front door

4 Top cover

5 Upper release latch

6 Stapler 1

7 Lower release latch
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Stapler/stacker with hole punch

2 3 4 5

1

7
6

8

9
1 Stapler/stacker output bins

2 Stapler/stacker output slot

3 Front door

4 Top cover

5 Upper release latch

6 Hole punch

7 Chad collector

8 Stapler 1

9 Lower release latch
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Booklet maker

1

2

4 5 6 7

3

9
8

10
11
12

13

1 Booklet output bin

2 Booklet output slot

3 Stapler/stacker output bins

4 Stapler/stacker output slot

5 Front door

6 Top cover

7 Upper release latch

8 Stapler 1

9 Upper paper delivery guide

10 Lower paper delivery guide

11 Saddle-stitch carriage, access to stapler 2 and stapler 3

12 Paper-advancement knobs for clearing jams

13 Lower release latch
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Product hardware setup and software installation
For basic setup instructions, see the Hardware Installation Guide that came with the product. For additional 
instructions, go to HP support on the Web.

In the US, go to www.hp.com/support/ljM806 for HP's all-inclusive help for your product.

Outside the US, follow these steps:

1. Go to www.hp.com/support.

2. Select your country/region.

3. Click Product Support & Troubleshooting.

4. Enter the product name, and then select Search.

Select your product to find the following support:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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2 Paper trays

● Configure trays for paper type and size

● Load Tray 1

● Load Tray 2 and Tray 3

● Load Tray 4 and Tray 5

● Configure the default staple location

● Configure the default hole punch location

For more information:

In the US, go to www.hp.com/support/ljM806.

Outside the US, go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Configure trays for paper type and size
The product automatically prompts you to configure a tray for type and size in the following situations:

● When you load paper into the tray

● When you specify a particular tray or paper type for a print job through the print driver or a software 
program and the tray is not configured to match the print-job’s settings

NOTE: The prompt does not display if you are printing from Tray 1, and Tray 1 is configured for the Any Size 
paper size and the Any Type paper type settings. In this situation, if the print job does not specify a tray, the 
product prints from Tray 1, even if the paper type and size settings in the print job do not match the paper 
loaded in Tray 1.

Configure a tray when loading paper
1. Load paper in the tray.

2. The tray configuration message displays on the product control panel.

3. Touch the OK button to accept the detected type and size, or touch the Modify button to choose a different 
paper size or type.

4. Select the correct type and size, and then touch the OK button.

Configure a tray to match print job settings
1. In the software program, specify the source tray, the paper size, and the paper type.

2. Send the job to the product.

If the tray needs to be configured, a tray configuration message displays on the product control panel.

3. Load the tray with the specified type and size of paper, and then close the tray.

4. Touch the OK button to accept the detected type and size, or touch the Modify button to choose a different 
paper size or type.

5. Select the correct type and size, and then touch the OK button.

Configure a tray by using the control panel
You can also configure the trays for type and size without a prompt from the product.

1. From the Home screen on the product control panel, scroll to and touch the Trays button.

2. Touch the line for the tray that you want to configure, and then touch the Modify button.

3. Select the paper type and size from the lists of options.

4. Touch the OK button to save your selection.
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Load Tray 1
CAUTION: To avoid jams, never add or remove paper from Tray 1 during printing.

1. Open Tray 1.  

2. Pull out the tray extension to support the paper.  
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3. Load paper in the tray. See Table 2-1 Tray 1 paper 
orientation on page 19.

TIP: To achieve the highest print-quality, HP 
recommends that you load the paper long-edge 
first.

 

4. Make sure that the paper fits under the fill line on 
the paper guides.

 

5. Adjust the side guides so that they lightly touch the 
paper stack, but do not bend it.
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Table 2-1  Tray 1 paper orientation

Paper type Image orientation Duplex mode How to load paper

Preprinted, letterhead, or labels Portrait 1-sided printing Face-up

Top edge toward the back of the product

  Automatic 2-sided printing Face-up

Top edge toward the back of the product

Prepunched Portrait 1-sided printing Face-down

Holes towards the right of the tray

Preprinted or letterhead Landscape 1-sided printing Face-up

Top edge toward the back of the product
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Table 2-1  Tray 1 paper orientation (continued)

Paper type Image orientation Duplex mode How to load paper

  Automatic 2-sided printing Face-up

Top edge toward the back of the product

Envelopes Short edge of the envelope 
feeding into the product

1-sided printing Face-up

Top edge toward the back of the product
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Load Tray 2 and Tray 3
NOTE: The procedure to load paper for Tray 3 is the same as for Tray 2. Only Tray 2 is shown here.

1. Open the tray.

NOTE: Do not open this tray while it is in use.

 

2. Adjust the paper-length and paper-width guides by 
squeezing the adjustment latches and sliding the 
guides to the size of the paper being used.

 

ENWW Load Tray 2 and Tray 3 21



3. Load paper into the tray. Check the paper to verify 
the guides lightly touch the stack, but do not bend 
it.

NOTE: To prevent jams, do not overfill the tray. 
Be sure that the top of the stack is below the tray 
full indicator.

NOTE: If the tray is not adjusted correctly, an 
error message might appear during printing or the 
paper might jam.

 

4. Close the tray.  

5. The control panel shows the tray’s paper type and 
size. If the configuration is not correct, follow the 
instructions on the control panel to change the 
type or size.

 

6. For custom-size paper, you need to specify the X 
and Y dimensions for the paper when the prompt 
displays on the product control panel.

 

Y
X
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Table 2-2  Tray 2 and Tray 3 paper orientation

Paper type Image orientation Duplex mode How to load paper

Preprinted or letterhead Portrait 1-sided printing Face-down

Top edge at the back of the tray

  Automatic 2-sided printing Face-up

Top edge at the back of the tray

 Landscape 1-sided printing Face-down

Bottom edge toward the right side of the tray

  Automatic 2-sided printing Face-up

Bottom edge toward the right side of the tray
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Table 2-2  Tray 2 and Tray 3 paper orientation (continued)

Paper type Image orientation Duplex mode How to load paper

Prepunched Portrait 1-sided printing Holes toward the right side of the tray

  Automatic 2–sided printing Holes toward the left side of the tray
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Load Tray 4 and Tray 5
Tray 4 and Tray 5 support only A4 and Letter-size paper.

1. Open the right and left sides of the tray.  

2. On each side, adjust the paper-size lever to the 
correct position for the paper you are using.
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3. Load full reams of paper into each side of the tray. 
The right side holds 1,500 sheets of paper. The left 
side holds 2,000 sheets of paper.

NOTE: For best results, load full reams of paper. 
Avoid dividing reams into smaller sections.

 

4. Close the right and left sides of the tray.  
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Configure the default staple location
1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● Stapler/Stacker Settings

● Stapling

3. Select a staple location from the list of options, and then touch the Save button. The following options are 
available:

● None

● Top left

● Top right

● Two left

● Two right

● Two top

● Two top or left

NOTE: For documents with portrait orientation, the staples are on the left. For documents with 
landscape orientation, the staples are on the top.

Configure the default hole punch location
1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● Stapler/Stacker Settings

● Hole Punching

3. Select a hole punch location from the list of options, and then touch the Save button. The following options 
are available:

● None

● Two left or top

● Two left

● Top right

● Two top

● Two bottom
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● Three left

● Three right

● Three top

● Three bottom

NOTE: For documents with portrait orientation, the holes are on the left. For documents with 
landscape orientation, the holes are on the top.
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3 Parts, supplies, and accessories

● Order parts, accessories, and supplies

● Replace the toner cartridge

For more information:

In the US, go to www.hp.com/support/ljM806.

Outside the US, go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Order parts, accessories, and supplies

Ordering

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Order using the HP Embedded Web Server (EWS) To access, in a supported Web browser on your computer, enter the 
product IP address or host name in the address/URL field. The EWS 
contains a link to the HP SureSupply Web site, which provides 
options for purchasing Original HP supplies.

Parts and supplies
The following parts are available for the product.

● Parts listed as Mandatory self-replacement are to be installed by customers, unless you are willing to pay
HP service personnel to perform the repair. For these parts, on-site or return-to-depot support is not
provided under the HP product warranty.

● Parts listed as Optional self-replacement can be installed by HP service personnel at your request for no
additional charge during the product warranty period.

Item Description Self-replacement options Part number

Maintenance Kit 110V Preventive maintenance kit that 
includes the following items:

● Replacement 110 Volt fuser

● Replacement transfer roller

● Replacement pickup, feed, and 
separation rollers for Tray 2 and 
Tray 3

● Replacement pickup and feed 
rollers for the High-capacity 
input feeder (Tray 4 and Tray 5)

Mandatory C2H67A
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Item Description Self-replacement options Part number

Maintenance Kit 220V Preventive maintenance kit that 
includes the following items:

● Replacement 220 Volt fuser

● Replacement transfer roller

● Replacement pickup, feed, and 
separation rollers for Tray 2 and 
Tray 3

● Replacement pickup and feed 
rollers for the High-capacity 
input feeder (Tray 4 and Tray 5)

Mandatory C2H57A

Tray 2-5 Roller Kit Replacement pickup and feed rollers 
that fit Trays 2, 3, 4, and 5 (order one 
kit for each tray)

Mandatory CF367-67903

Tray 1 roller kit Replacement pickup and feed rollers 
for Tray 1

Mandatory CF367-67904

110V Fuser Kit Replacement 110 Volt fuser Mandatory CF367-67905

220V Fuser Kit Replacement 220 Volt fuser Mandatory CF367-67906

Transfer Roller Kit Replacement transfer roller Mandatory CF367-67907

HCI Kit Replacement high-capacity input 
feeder and stand

Mandatory C3F79-37901

Stapler/Stacker Kit Replacement Stapler/Stacker finishing 
accessory

Mandatory CZ994-67901

Stapler/Stacker 2/3 Hole Punch Kit Replacement Stapler/Stacker with 
Hole Punch finishing accessory, 2 or 3 
hole version for countries/regions 
that use imperial measurements

Mandatory CZ995-67901

Stapler/Stacker 2/4 Hole Punch Kit Replacement Stapler/Stacker with 
Hole Punch finishing accessory, 2 or 4 
hole version for countries/regions 
that use metric measurements

Mandatory CZ996-67901

Booklet Maker Kit Replacement Booklet Maker finishing 
accessory

Mandatory CZ285-67901

Limiter, Torque Kit Replacement separation-roller torque 
limiter for Tray 2 or Tray 3 (order one 
kit for each tray)

Mandatory CF367-67908

Staple Cartridge Refill Kit Replacement staple cartridge for 
Stapler 1 in the Stapler/Stacker, 
Stapler/Stacker with Hole Punch, or 
the Booklet Maker

Mandatory C8091A

2000-Staple Cartridge Kit (2-pack) Replacement set of staple cartridges 
for Stapler 2 and 3 in the Booklet 
Maker

Mandatory CC383A

Black Toner Cartridge Replacement high-capacity toner 
cartridge

Mandatory CF325X

USB Wireless Print Server Kit Replacement HP Jetdirect ew2500 
wireless print server

Mandatory J8026-67901
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Item Description Self-replacement options Part number

512 MB DIMM Kit Replacement 512 MB DIMM Mandatory CF306-67901

Control Panel Assembly Kit Replacement control-panel assembly Mandatory CZ245-67901

Formatter Kit Replacement formatter Mandatory CF367-67912

HDD Replacement Kit Replacement hard disk drive Optional CF367-67913

Accessories

Item Description Part number

HP LaserJet Stapler/Stacker Stapler/stacker finishing accessory CZ994A

HP LaserJet Stapler/Stacker with 2/3 hole punch Stapler/stacker with hole punch finishing accessory 
for countries/regions that use imperial 
measurements

CZ995A

HP LaserJet Stapler/Stacker with 2/4 hole punch Stapler/stacker with hole punch finishing accessory 
for countries/regions that use metric measurements

CZ996A

HP LaserJet Booklet Maker/Finisher Booklet maker finishing accessory CZ285A

HP LaserJet 3,500-sheet High-Capacity Input Feeder 
and Stand

Optional tray to increase paper capacity C3F79A

HP Jetdirect ew2500 Wireless Print Server USB wireless print server J8026A

HP Jetdirect 2800w NFC & Wireless Direct Accessory Wireless direct accessory for “touch” printing from 
mobile devices

J8029A

HP 1GB DIMM Optional memory module CF306AX
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Replace the toner cartridge
Continue printing with the current cartridge until redistributing the toner no longer yields acceptable print quality. 
To redistribute the toner, remove the toner cartridge from the printer and gently rock the cartridge back and forth 
about its horizontal axis. For graphical representation, see cartridge replacement instructions. Reinsert the toner 
cartridge into the printer and close the cover.

The following illustration shows the toner-cartridge components.

Figure 3-1  Toner cartridge components, back view

12

1 Imaging drum

CAUTION: Do not touch the green roller. Doing so can damage the cartridge.

2 Memory chip

CAUTION: If toner gets on clothing, wipe it off by using a dry cloth and wash the clothes in cold water. Hot water 
sets toner into fabric.

NOTE: Information about recycling used toner cartridges is on the toner cartridge box.
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1. Open the front door. Make sure that the door is 
completely open.

 

2. Push the button on the lever, and then rotate the 
toner-cartridge lever to the down position.

 

3. Grasp the handle of the used toner cartridge and 
pull out to remove it.
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4. Remove the new toner cartridge from its protective 
bag.

 

5. Hold both ends of the toner cartridge and rock it 
5-6 times.

 

6. Align the toner cartridge with its slot, and then 
insert the toner cartridge into the product. The 
toner cartridge will drop slightly when it is in place.
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7. Push the button on the lever, and then rotate the 
toner-cartridge lever to the up position.

 

8. Close the front door.  
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4 Print

● Print tasks (Windows)

● Print tasks (Mac OS X)

● Store print jobs on the product

● Mobile printing

● Print from the USB port

For more information:

In the US, go to www.hp.com/support/ljM806.

Outside the US, go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Print tasks (Windows)

How to print (Windows)
The following procedure describes the basic printing process for Windows.

1. From the software program, select the Print option.

2. Select the product from the list of printers, and then select Properties or Preferences (the name varies for 
different software programs).

3. Click or tap the tabs in the print driver to configure the available options.

4. Click or tap the OK button to return to the Print dialog box. Select the number of copies to print from this 
screen.

5. Click or tap the OK button to print the job.
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Automatically print on both sides (Windows)

NOTE: Your print driver might look different than what is shown here, but the steps are the same.

1. From the software program, select the Print 
option.

 

2. Select the product from the list of printers, and 
then select Properties or Preferences (the name 
varies for different software programs).

 

3. Click the Finishing tab.  
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4. Select the Print on both sides check box. Click the 
OK button to close the Document Properties dialog 
box.

 

5. In the Print dialog box, click the OK button to print 
the job.
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Manually print on both sides (Windows) 

NOTE: Your print driver might look different than what is shown here, but the steps are the same.

1. From the software program, select the Print 
option.

 

2. Select the product from the list of printers, and 
then select Properties or Preferences (the name 
varies for different software programs).

 

3. Click the Finishing tab.  
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4. Select the Print on both sides check box. Click the 
OK button to print the first side of the job.

 

5. Retrieve the printed stack from the output bin, and 
then place it with the printed-side facing up in 
Tray 1.

 

6. If prompted, touch the appropriate control panel 
button to continue.
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Print multiple pages per sheet (Windows)

NOTE: Your print driver might look different than what is shown here, but the steps are the same.

1. From the software program, select the Print 
option.

 

2. Select the product from the list of printers, and 
then select Properties or Preferences (the name 
varies for different software programs).

 

3. Click the Finishing tab.  
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4. Select the number of pages per sheet from the 
Pages per sheet drop-down list.

 

5. Select the correct Print page borders, Page order, 
and Orientation options. Click the OK button to 
close the Document Properties dialog box.

 

6. In the Print dialog box, click the OK button to print 
the job.

 

44 Chapter 4   Print ENWW



Select the paper type (Windows)

NOTE: Your print driver might look different than what is shown here, but the steps are the same.

1. From the software program, select the Print 
option.

 

2. Select the product from the list of printers, and 
then select Properties or Preferences (the name 
varies for different software programs).

 

3. Click the Paper/Quality tab.  
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4. From the Paper type drop-down list, click the 
More... option.

 

5. Expand the list of Type is: options.  

6. Expand the category of paper types that best 
describes your paper.
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7. Select the option for the type of paper you are 
using, and then click the OK button.

 

8. Click the OK button to close the Document 
Properties dialog box. In the Print dialog box, click 
the OK button to print the job.
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Print tasks (Mac OS X)

How to print (Mac OS X)
The following procedure describes the basic printing process for Mac OS X.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. Open the menus drop-down list or click Show Details, and then select other menus to adjust the print 
settings.

4. Click the Print button.

Automatically print on both sides (Mac OS X)

NOTE: This feature is available if you install the HP print driver. It might not be available if you are using AirPrint.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. Open the menus drop-down list or click Show Details, and then click the Layout menu.

4. Select a binding option from the Two-Sided drop-down list.

5. Click the Print button.

Manually print on both sides (Mac OS X)

NOTE: This feature is available if you install the HP print driver. It might not be available if you are using AirPrint.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select this product.

3. Open the menus drop-down list or click Show Details, and then click the Manual Duplex menu.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button.

6. Go to the product, and remove any blank paper that is in Tray 1.

7. Retrieve the printed stack from the output bin and place it with the printed-side facing down in the input 
tray.

8. If prompted, touch the appropriate control panel button to continue.
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Print multiple pages per sheet (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. Open the menus drop-down list or click Show Details, and then click the Layout menu.

4. From the Pages per Sheet drop-down list, select the number of pages that you want to print on each sheet.

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

7. Click the Print button.

Select the paper type (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. Open the menus drop-down list or click Show Details, and then click the Finishing menu.

4. Select a type from the Media-type drop-down list.

5. Click the Print button.
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Store print jobs on the product

Create a stored job (Windows)
You can store jobs on the product so you can print them at any time.

NOTE: Your print driver might look different than what is shown here, but the steps are the same.

1. From the software program, select the Print 
option.

 

2. Select the product from the list of printers, and 
then select Properties or Preferences (the name 
varies for different software programs).

 

3. Click the Job Storage tab.  
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4. Select a Job Storage Mode option.

● Proof and Hold: Print and proof one copy of a 
job, and then print more copies.

● Personal Job: The job does not print until you 
request it at the product control panel. For this 
job-storage mode, you can select one of the 
Make Job Private/Secure options. If you assign 
a personal identification number (PIN) to the 
job, you must provide the required PIN at the 
control panel. If you encrypt the job, you must 
provide the required password at the control 
panel.

● Quick Copy: Print the requested number of 
copies of a job and store a copy of the job in 
the product memory so you can print it again 
later.

● Stored Job: Store a job on the product and 
allow other users to print the job at any time. 
For this job-storage mode, you can select one 
of the Make Job Private/Secure options. If you 
assign a personal identification number (PIN) 
to the job, the person who prints the job must 
provide the required PIN at the control panel. If 
you encrypt the job, the person who prints the 
job must provide the required password at the 
control panel.
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5. To use a custom user name or job name, click the 
Custom button, and then enter the user name or 
the job name.

Select which option to use if another stored job 
already has that name:

● Use Job Name + (1-99): Append a unique 
number to the end of the job name.

● Replace Existing File: Overwrite the existing 
stored job with the new one.

 

6. Click the OK button to close the Document 
Properties dialog box. In the Print dialog box, click 
the OK button to print the job.

 

Create a stored job (Mac OS X)
You can store jobs on the product so you can print them at any time.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then 
click the Job Storage menu.

4. In the Mode drop-down list, select the type of stored job.

● Proof and Hold: Print and proof one copy of a job, and then print more copies.

● Personal Job: The job does not print until you request it at the product control panel. If you assign a 
personal identification number (PIN) to the job, you must provide the required PIN at the control 
panel.
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● Quick Copy: Print the requested number of copies of a job and store a copy of the job in the product 
memory so you can print it again later.

● Stored Job: Store a job on the product and allow other users to print the job at any time. If you assign 
a personal identification number (PIN) to the job, the person who prints the job must provide the 
required PIN at the control panel.

5. To use a custom user name or job name, click the Custom button, and then enter the user name or the job 
name.

Select which option to use if another stored job already has that name.

● Use Job Name + (1-99): Append a unique number to the end of the job name.

● Replace Existing File: Overwrite the existing stored job with the new one.

6. If you selected the Stored Job or Personal Job option in step 3, you can protect the job with a PIN. Type a 4-
digit number in the Use PIN to Print field. When other people attempt to print this job, the product prompts 
them to enter this PIN number.

7. Click the Print button to process the job.

Print a stored job
Use the following procedure to print a job that is stored in the product memory.

1. From the Home screen on the product control panel, scroll to and touch the Retrieve from Device Memory 
button.

2. Select the name of the folder where the job is stored.

3. Select the name of the job. If the job is private or encrypted, enter the PIN or password.

4. Adjust the number of copies, and then touch the Start  button to print the job.

Delete a stored job
When you send a stored job to the product memory, the product overwrites any previous jobs with the same 
user and job name. If a job is not already stored under the same user and job name, and the product needs 
additional space, the product might delete other stored jobs starting with the oldest. You can change the number 
of jobs that the product can store from the General Settings menu on the product control panel.

Use this procedure to delete a job that is stored in the product memory.

1. From the Home screen on the product control panel, scroll to and touch the Retrieve from Device Memory 
button.

2. Select the name of the folder where the job is stored.

3. Select the name of the job, and then touch the Delete button.

4. If the job is private or encrypted, enter the PIN or the password, and then touch the Delete button.
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Mobile printing
HP offers multiple Mobile and ePrint solutions to enable wireless printing to an HP printer from a laptop, tablet, 
smartphone, or other mobile device. To determine the best choice for your needs, go to www.hp.com/go/
LaserJetMobilePrinting (English only).

HP ePrint
Use HP ePrint to print documents by sending them as an email attachment to the product's email address from 
any email enabled device.

NOTE: The product might require a firmware update to use this feature.

To use HP ePrint, the product must meet these requirements:

● The product must be connected to a wired or wireless network and have Internet access.

● HP Web Services must be enabled on the product, and the product must be registered with HP Connected.

1. Type the product IP address into the address line of a Web browser to open the HP Embedded Web 
Server.

2. Click the HP Web Services tab.

3. Select the option to enable Web Services.

NOTE: Enabling Web Services might take several minutes.

4. Go to www.hpconnected.com to create an HP ePrint account and complete the setup process.

For more information, go to www.hp.com/go/support to review additional support information for your product.

HP ePrint software
The HP ePrint software makes it easy to print from a desktop or laptop computer to any HP ePrint-capable 
product. After installing the software, open the Print option from within your application, and then select HP 
ePrint from the installed printers list. This software makes it easy to find HP ePrint-enabled products that are 
registered to your HP Connected account. The target HP product can be at your desk or in a remote location, such 
as a branch office or across the globe.

For Windows, the HP ePrint software also supports traditional direct IP printing to local network printers on the 
network (LAN or WAN) to supported PostScript® products.

Go to www.hp.com/go/eprintsoftware for drivers and information.

NOTE: The HP ePrint software is a PDF workflow utility for Mac, and is not technically a print driver. HP ePrint 
software for Mac supports print paths only through HP Connected and does not support direct IP printing to local 
network printers.
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AirPrint
Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to the product 
from an iPad, iPhone (3GS or later), or iPod touch (third generation or later) in the following applications:

● Mail

● Photos

● Safari

● iBooks

● Select third-party applications

To use AirPrint, the product must be connected to the same wireless network as the Apple device. For more 
information about using AirPrint and about which HP products are compatible with AirPrint, go to 
www.hp.com/go/airprint.

NOTE: AirPrint does not support USB connections.
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Print from the USB port
This product features easy-access USB printing, so you can quickly print files without sending them from a 
computer. The product accepts standard USB flash drives in the USB port on the front of the product. You can 
print the following types of files:

● .pdf

● .prn

● .pcl

● .ps

● .cht

Enable the USB port for printing
Before you can use this feature, you must enable the USB port. Use the following procedure to enable the port 
from the product control-panel menus:

1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● General Settings

● Enable Retrieve from USB

3. Select the Enable option, and then touch the Save button.

Print USB documents
1. Insert the USB flash drive into the easy-access USB port.

NOTE: You might need to remove the cover from the USB port. Pull the cover straight out to remove it.

2. The product detects the USB flash drive. Touch the OK button to access the drive, or, if prompted, select the 
Retrieve from USB option from the list of available applications. The Retrieve from USB screen opens.

3. Select the name of the document that you want to print.

NOTE: The document might be in a folder. Open folders as necessary.

4. To adjust the number of copies, touch the Copies field, and then use the keypad to select the number of 
copies.

5. Touch the Start  button to print the document.
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5 Manage the product

● HP Embedded Web Server

● HP Utility for Mac OS X

● Use HP Web Jetadmin software

● Economy settings

● Product security features

● Software and firmware updates

For more information:

In the US, go to www.hp.com/support/ljM806.

Outside the US, go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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HP Embedded Web Server
Use the HP Embedded Web Server to manage printing functions from your computer instead of the product 
control panel.

● View product status information

● Determine the remaining life for all supplies and order new ones

● View and change tray configurations

● View and change the product control-panel menu configuration

● View and print internal pages

● Receive notification of product and supplies events

● View and change network configuration

The HP Embedded Web Server works when the product is connected to an IP-based network. The HP Embedded 
Web Server does not support IPX-based product connections. You do not have to have Internet access to open 
and use the HP Embedded Web Server.

When the product is connected to the network, the HP Embedded Web Server is automatically available.

How to access the HP Embedded Web Server (EWS)
1. Identify the product IP address or host name. If the Network  button is visible on the Home screen on the 

product control panel, touch that button to display the address. Otherwise, follow these steps to print or 
view the product configuration page:

a. From the Home screen on the product control panel, scroll to and touch the Administration button.

b. Open the following menus:

– Reports

– Configuration/Status Pages

– Configuration Page

c. Touch the Print or View button.

d. Find the IP address or host name on the Jetdirect page.

2. In a supported Web browser on your computer, enter the product IP address or host name in the 
address/URL field.

To use the HP Embedded Web Server, your browser must meet the following requirements:

● Windows: Microsoft Internet Explorer 5.01 or later or Netscape 6.2 or later

● Mac OS X: Safari or Firefox using Bonjour or an IP address

● Linux: Netscape Navigator only

● HP-UX 10 and HP-UX 11: Netscape Navigator 4.7
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HP Utility for Mac OS X
Use the HP Utility for Mac OS X to check product status or to view or change product settings from your 
computer.

You can use the HP Utility when the product is connected with a USB cable or is connected to a TCP/IP-based 
network.

Open HP Utility
From the Finder, click Applications, click HP, and then click HP Utility.

If HP Utility is not included in the Utilities list, use the following procedure to open it:

1. At the computer, open the Apple  menu, click the System Preferences menu, and then click the Print & 
Fax icon or the Print & Scan icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Utility tab.

5. Click the Open Printer Utility button.

HP Utility features
The HP Utility toolbar is at the top of every page. It includes these items:

● Devices: Click this button to show or hide Mac products found by the HP Utility in the Printers pane at the 
left side of the screen.

● All Settings: Click this button to return to the HP Utility main page.

● Applications: Click this button to manage which HP tools or utilities appear in the Dock.

● HP Support: Click this button to open a browser and go to the HP support Web site for the product.

● Supplies: Click this button to open the HP SureSupply Web site.

● Registration: Click this button to open the HP registration Web site.

● Recycling: Click this button to open the HP Planet Partners Recycling Program Web site.

HP Utility consists of pages that you open by clicking in the All Settings list. The following table describes the 
tasks that you can perform with HP Utility.

Menu Item Description

Information and Support Supplies Status Shows the product supplies status and provides links for ordering supplies 
online.

 Device Information Shows information about the currently selected product.

 File Upload Transfers files from the computer to the product.

 Upload Fonts Transfers font files from the computer to the product.

 HP Connected Accesses the HP Connected Web site.
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Menu Item Description

 Update Firmware Transfers a firmware update file to the product.

NOTE: This option is available only after you open the View menu and 
select the Show Advanced Options item.

 Commands Sends special characters or print commands to the product after the print 
job.

NOTE: This option is available only after you open the View menu and 
select the Show Advanced Options item.

Printer Settings Supplies Management Configures how the product should behave when supplies are nearing the 
end of their estimated life.

 Trays Configuration Changes the default tray settings.

 Output Devices Manages settings for optional output accessories.

 Duplex Mode Turns on the automatic two-sided printing mode.

 Protect Direct Ports Disables printing over USB or parallel ports.

 Stored Jobs Manages print jobs that are stored on the product hard disk.

 Network Settings Configures the network settings, such as the IPv4 and IPv6 settings.

 Additional Settings Provides access to the HP Embedded Web Server.
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Use HP Web Jetadmin software
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of networked 
HP products, including printers, multifunction products, and digital senders. This single solution allows you to 
remotely install, monitor, maintain, troubleshoot, and secure your printing and imaging environment — 
ultimately increasing business productivity by helping you save time, control costs, and protect your investment.

HP Web Jetadmin upgrades are periodically made available to provide support for specific product features. Go to 
www.hp.com/go/webjetadmin and click the Self Help and Documentation link to learn more about upgrades.
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Economy settings
● Print with EconoMode

● Set Sleep mode

● Set the Sleep Schedule

Print with EconoMode
This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less toner. 
However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might 
outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer acceptable, 
consider replacing the toner cartridge.

NOTE: If this option is not available in your print driver, you can set it using the product control panel.

Configure EconoMode from the print driver

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the EconoMode check box to enable the feature, and then click OK.

Configure EconoMode from the product control panel

1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● General Settings

● Print Quality

3. Scroll to and select EconoMode.

4. Touch On or Off to enable or disable the feature, and then touch Save.

Set Sleep mode
1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● General Settings

● Energy Settings

● Sleep Timer Settings
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3. Touch Sleep Mode/Auto Off After to select the option.

4. Select the appropriate time period, and then touch the Save button.

Set the Sleep Schedule

NOTE: You must configure the date and time settings before you can use the Sleep Schedule feature.

1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● General Settings

● Date/Time Settings

3. Open the Date/Time Format menu and configure the following settings:

● Date Format

● Time Format

4. Touch the Save button.

5. Open the Date/Time menu and configure the following settings:

● Date/Time

● Time Zone

If you are in an area that uses daylight savings time, select the Adjust for Daylight Savings box.

6. Touch the Save button.

7. Touch the back-arrow button to return to the Administration screen.

8. Open the following menus:

● General Settings

● Energy Settings

● Sleep Schedule

9. Touch the Add  button, and then select the type of event to schedule: Wake or Sleep.

10. Configure the following settings:

● Time

● Event Days

11. Touch the OK button, and then touch the Save button.
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Product security features
● Security statements

● IP Security

● Sign in to the product

● Assign a system password

● Encryption support: HP High Performance Secure Hard Disks

Security statements
The product supports security standards and recommended protocols that help you keep the product secure, 
protect critical information on your network, and simplify the way you monitor and maintain the product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/secureprinting. 
The site provides links to white papers and FAQ documents about security features.

IP Security
IP Security (IPsec) is a set of protocols that control IP-based network traffic to and from the product. IPsec 
provides host-to-host authentication, data integrity, and encryption of network communications.

For products that are connected to the network and have an HP Jetdirect print server, you can configure IPsec by 
using the Networking tab in the HP Embedded Web Server.

Sign in to the product
Some features on the product control panel can be secured so that unauthorized people cannot use them. When 
a feature is secured, the product prompts you to sign in before you can use it. You can also sign in without 
waiting for a prompt by touching the Sign In button on the Home screen.

Typically, you use the same user name and password that you use to sign in to your computer on the network. 
Consult the network administrator for this product if you have questions about which credentials to use.

After you have signed in to the product, a Sign Out button displays on the control panel. To maintain security for 
the product, touch the Sign Out button when you have finished using the product.

Assign a system password
Assign an administrator password for access to the product and the HP Embedded Web Server so that 
unauthorized users cannot change the product settings.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a Web 
browser.

2. Click the Security tab.

3. Open the General Security menu.

4. In the Username field, enter the name to associate with the password.

5. Enter the password in the New Password field, and then enter it again in the Verify Password field.
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NOTE: If you are changing an existing password, you must first enter the existing password in the Old 
Password field.

6. Click the Apply button. Make note of the password and store it in a safe place.

Encryption support: HP High Performance Secure Hard Disks
The hard disk provides hardware-based encryption so you can securely store sensitive data without impacting 
product performance. This hard disk uses the latest Advanced Encryption Standard (AES) and has versatile time-
saving features and robust functionality.

Use the Security menu in the HP Embedded Web Server to configure the disk.
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Software and firmware updates
HP regularly updates features that are available in the product firmware. To take advantage of the most current 
features, update the product firmware. Download the most recent firmware update file from the Web:

● In the US, go to www.hp.com/support/ljM806. Click Drivers & Software.

● Outside the US, go to www.hp.com/support. Select your country/region. Click Drivers & Software. Enter the 
product name (for example, “LaserJet M575”), and then select Search.
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6 Solve problems

● Restore factory-set defaults

● Control panel help system

● A “Cartridge is low” or “Cartridge is very low” message displays on the printer control panel

● Product does not pick up paper or misfeeds

● Clear jams

● Improve print quality

● Solve wired network problems

For more information:

In the US, go to www.hp.com/support/ljM806.

Outside the US, go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Restore factory-set defaults
1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● General Settings

● Restore Factory Settings

3. A verification message advises that completing the reset function might result in loss of data. Touch the 
Reset button to complete the process.

NOTE: The product restarts automatically after the reset operation completes.
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Control panel help system
The product has a built-in Help system that explains how to use each screen. To open the Help system, touch the 
Help  button in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can browse 
through the menu structure by touching the buttons in the menu.

Some Help screens include animations that guide you through procedures, such as clearing jams.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options for that 
screen.

If the product alerts you of an error or warning, touch the Help  button to open a message that describes the 
problem. The message also contains instructions to help solve the problem.
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A “Cartridge is low” or “Cartridge is very low” message displays on 
the printer control panel

Cartridge is low: The printer indicates when a toner cartridge level is low. Actual toner cartridge life remaining 
may vary. Consider having a replacement available to install when print quality is no longer acceptable. The toner 
cartridge does not need to be replaced now.

Continue printing with the current cartridge until redistributing the toner no longer yields acceptable print quality. 
To redistribute the toner, remove the toner cartridge from the printer and gently rock the cartridge back and forth 
about its horizontal axis. For graphical representation, see cartridge replacement instructions. Reinsert the toner 
cartridge into the printer and close the cover.

Cartridge is very low: The printer indicates when the toner cartridge level is very low. Actual toner cartridge life 
remaining may vary. Consider having a replacement available to install when print quality is no longer 
acceptable. The toner cartridge does not need to be replaced now unless the print quality is no longer 
acceptable.

Once an HP toner cartridge has reached Very Low, HP’s Premium Protection Warranty on that toner cartridge has 
ended.

Change the “Very Low” settings
You can change the way the printer reacts when supplies reach the Very Low state. You do not have to re-
establish these settings when you install a new toner cartridge.

1. From the Home screen on the product control panel, scroll to and select Supplies.

2. Open the following menus:

● Manage Supplies

● Supply Settings

● Black Cartridge or Color Cartridges

● Very Low Settings

3. Select one of the following options:

● Select the Stop option to set the printer to stop printing when the cartridge reaches the Very Low 
threshold.

● Select the Prompt to continue option to set the printer to stop printing when the cartridge reaches the 
Very Low threshold. You can acknowledge the prompt or replace the cartridge to resume printing.

● Select the Continue option to set the printer to alert you that the cartridge is very low, and to continue 
printing beyond the Very Low setting without interaction. This can result in unsatisfactory print 
quality.

For products with fax capability

When the printer is set to the Stop or Prompt to continue option, there is some risk that faxes will not print when 
the prrinter resumes printing. This can occur if the printer has received more faxes than the memory can hold 
while the printer is waiting.

The printer can print faxes without interruption when it passes the Very Low threshold if you select the Continue 
option for the toner cartridge, but print quality might degrade.
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Order supplies

Order supplies and paper www.hp.com/go/suresupply

Order through service or support providers Contact an HP-authorized service or support provider.

Order using the HP Embedded Web Server (EWS) To access, in a supported Web browser on your computer, enter the 
printer IP address or host name in the address/URL field. The EWS 
contains a link to the HP SureSupply Web site, which provides 
options for purchasing Original HP supplies.
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Product does not pick up paper or misfeeds
● The product does not pick up paper

● The product picks up multiple sheets of paper

● The document feeder jams, skews, or picks up multiple sheets of paper

The product does not pick up paper
If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper size and type are set correctly on the product control panel.

4. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to the 
appropriate indentation in the tray.

5. Check the product control panel to see if the product is waiting for you to acknowledge a prompt to feed 
the paper manually. Load paper, and continue.

6. The rollers above the tray might be contaminated. Clean the rollers with a lint-free cloth dampened with 
warm water.

The product picks up multiple sheets of paper
If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the 
paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to the 
appropriate indentation in the tray.

6. Make sure the printing environment is within recommended specifications.

The document feeder jams, skews, or picks up multiple sheets of paper

NOTE: This information applies to MFP products only.

● The original might have something on it, such as staples or self-adhesive notes, that must be removed.

● Check that all rollers are in place and that the roller-access cover inside the document feeder is closed.

● Make sure that the top document-feeder cover is closed.
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● The pages might not be placed correctly. Straighten the pages and adjust the paper guides to center the 
stack.

● The paper guides must be touching the sides of the paper stack to work correctly. Make sure that the paper 
stack is straight and the guides are against the paper stack.

● The document feeder input tray or output bin might contain more than the maximum number of pages. 
Make sure the paper stack fits below the guides in the input tray, and remove pages from the output bin.

● Verify that there are no pieces of paper, staples, paper clips, or other debris in the paper path.

● Clean the document-feeder rollers and the separation pad. Use compressed air or a clean, lint-free cloth 
moistened with warm water. If misfeeds still occur, replace the rollers.

● From the Home screen on the product control panel, scroll to and touch the Supplies button. Check the 
status of the document-feeder kit, and replace it if necessary.
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Clear jams

Auto-navigation for clearing jams
The auto-navigation feature assists you in clearing jams by providing step-by-step instructions on the control 
panel. When you complete a step, the product displays instructions for the next step until you have completed all 
steps in the procedure.

Experiencing frequent or recurring paper jams?
To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so they 
are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and feed sheets 
one at a time.

8. From the Home screen on the product control panel, scroll to and touch the Trays button. Verify that the 
tray is configured correctly for the paper type and size.

9. Make sure the printing environment is within recommended specifications.
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Clear jams in the front door

1. Open the front door. Make sure that the door is 
completely open.

 

2. Push the button on the lever, and then rotate the 
toner-cartridge lever to the down position.

 

3. Grasp the handle of the toner cartridge and pull 
out to remove it.
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4. Turn the green knob counter-clockwise, and then 
remove the jammed paper.

 

5. Align the toner cartridge with its slot, and then 
insert the toner cartridge into the product. The 
toner cartridge will drop slightly when it is in place.
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6. Push the button on the lever, and then rotate the 
toner-cartridge lever to the up position.

 

7. Close the front door.  
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Clear jams in Tray 1

1. If jammed paper is visible in Tray 1, clear the jam 
by pressing the jam release button under the tray 
and gently pulling the paper straight out.

 

2. If you cannot remove the paper, or if no jammed 
paper is visible in Tray 1, open the right door.

 

3. If jammed paper is in the Tray 1 feed area, lift the 
jam access cover and remove the paper.
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4. Pull the jam-access cover lever out, and then lift it 
to open it.

 

5. Gently pull the paper out of the pickup area.  
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6. Pull the jam-access cover lever out, and then lower 
it to close it.

 

7. Close the right door.  
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Clear jams in the right door

1. Open the right door.  

2. If there is jammed paper in the door, lift the jam 
access-cover, and then gently pull the paper 
straight out.

 

3. If there is jammed paper visible at the bottom of 
the door, gently pull it straight down.

 

ENWW Clear jams 81



4. Pull the jam-access cover lever out, and then lift it 
to open it.

 

5. Gently pull the paper out of the pickup area.  
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6. Pull the jam-access cover lever out, and then lower 
it to close it.

 

7. Close the right door.  
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Clear jams in Tray 2 and Tray 3

NOTE: The procedure to clear jams for Tray 3 is the same as for Tray 2. Only Tray 2 is shown here.

1. Open the tray.  
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2. Remove any jammed or damaged sheets of paper.  

3. Reinsert and close the tray.  
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Clear jams in Tray 4 and Tray 5 

1. Open the right and left trays.

NOTE: You do not need to load both trays at the 
same time.

 

2. Remove the paper from the trays and discard any 
damaged sheets.

 

3. Above the right-side tray, press the green button to 
release the jam-access plate.
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4. If jammed paper is in the feed area, pull it down to 
remove it.

 

5. Push up on the jam-access plate to close it.  

6. Load full reams of paper into each side of the tray. 
The right side holds 1,500 sheets of paper. The left 
side holds 2,000 sheets of paper.

NOTE: For best results, load full reams of paper. 
Avoid dividing reams into smaller sections.
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7. Close the right and left trays.  

8. Open the jam-access door on the right side of the 
high-capacity tray cabinet.
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9. Remove any jammed paper.  

10. Close the jam-access door on the right side of the 
high-capacity tray cabinet.

NOTE: If after clearing the jam the product 
control panel displays a message that there is no 
paper in the tray or the tray is over filled, remove 
the tray and look behind it for any remaining paper.

 

ENWW Clear jams 89



Clear jams in the duplexer

1. Pull the release handle on the top of the finishing 
accessory, and then slide the finisher away from 
the product until it stops.

 

2. Open the left door.  

3. Lift the jam access cover on the duplexer.  
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4. Gently remove any jammed or damaged paper 
from this area by pulling it out of the product.

 

5. Press down on the latch to release the duplexer.  

6. Pull the duplexer straight out of the product until it 
stops.
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7. Lift the first jam-access cover, and then remove 
any jammed paper.

 

8. Lift the second jam-access cover, and then remove 
any jammed paper.

 

9. Open the front door.  
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10. Remove any jammed paper from the opening 
below the toner-cartridge area.

 

11. Close the front door.  

12. Slide the duplexer into the slot until it locks into 
place.
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13. Close the left door.  

14. Attach the finishing accessory.  
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Clear jams in the left door (fuser area)

WARNING! The fuser can be hot while the product is in use.

1. Lift the release handle on the top of the finishing 
accessory, and then slide the finisher away from 
the product until it stops.

 

2. Open the left door of the product.  
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3. Push down to release the latch on the duplexer.  

4. Pull the duplexer straight out of the product until it 
stops.

 

5. Open the jam-access cover.

WARNING! The fuser can be hot while the product 
is in use.
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6. Gently remove the jammed paper.  

7. Slide the duplexer into the slot until it locks into 
place.
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8. Close the left door.  

9. Attach the finisher.  
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Clear jams in the output bin area

1. If a finishing accessory is not attached to the 
product and paper is visible from the output bin, 
grasp the leading edge and remove it.

 

2. If a finishing accessory is attached to the product, 
lift the handle to open the top cover of the finishing 
accessory.

 

3. Remove jammed paper from the inside of the 
finishing accessory.
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4. Close the top cover of the finishing accessory.  

5. Lift the jam-access cover for the output slot. If you 
can see any jammed paper, gently pull it out.
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Clear jams in the stapler/stacker accessory
● Clear jams in the stapler/stacker

● Clear connection jams

● Clear Staple 1 jams

Clear jams in the stapler/stacker

1. Open the top left door.  

2. Lift the jam access cover for the output slot, and 
gently remove any jammed paper.
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3. Remove all paper from the top left door area.  

4. Close the top left door.  
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Clear connection jams

1. Pull the release handle on the top of the finishing 
accessory, and then slide the finisher away from 
the product until it stops.

 

2. Remove any paper from the area.  

3. Attach the finishing accessory.  
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Clear Staple 1 jams

1. Lift the jam access cover for the output slot, and 
gently remove any jammed paper.

 

2. Wait three seconds, and then open the front left 
door.

 

3. Pull the staple cartridge up and out to remove it.  
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4. Lift up the metal handle on the front of the staple 
cartridge.

 

5. Remove any jammed staples from the staple 
cartridge.

 

6. Push down the metal handle on the front of the 
staple cartridge.
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7. Insert the staple cartridge. Press down on the top 
of the staple cartridge until it clicks into place.

 

8. Close the front left door.  
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Clear jams in the stapler/stacker with hole punch accessory
● Clear top left door jams in the stapler/stacker with hole punch accessory

● Clear a connection jam in the stapler/stacker with hole punch accessory

● Clear Staple 1 jams

Clear top left door jams in the stapler/stacker with hole punch accessory

1. Open the front left door.  

2. Open the top left door.  
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3. Turn the knob to align the arrows.  

1

2

4. Lift the hole-punch unit.  

5. Lift the jam access cover for the output slot, and 
gently remove any jammed paper.
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6. Remove jammed paper from top left cover area.  

7. Close the hole-punch unit.

NOTE: Ensure the notch on the hole punch is 
positioned as shown in the graphic.
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8. Close the top left door.  

9. Close the front left door.  
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Clear a connection jam in the stapler/stacker with hole punch accessory

1. Pull the release handle on the top of the finishing 
accessory, and then slide the finisher away from 
the product until it stops.

 

2. Remove any paper from the area.  

3. Open the front left door.  
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4. Open the top left door.  

5. Turn the knob to align the arrows, and then gently 
pull out the jammed paper.

 

1

2

6. If you cannot remove the jammed paper, lift the 
hole-punch unit.
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7. Remove the jammed paper from the bottom of the 
hole-punch unit.

 

8. Close the hole-punch unit.

NOTE: Ensure the arrow on the hole-punch knob 
is positioned as shown in the graphic.

 

9. Close the top left door.  
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10. Close the front left door.  

11. Attach the finishing accessory to the product.  
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Clear Staple 1 jams

1. Lift the jam access cover for the output slot, and 
gently remove any jammed paper.

 

2. Wait three seconds, and then open the front left 
door.

 

3. Pull the staple cartridge up and out to remove it.  
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4. Lift up the metal handle on the front of the staple 
cartridge.

 

5. Remove any jammed staples from the staple 
cartridge.

 

6. Push down the metal handle on the front of the 
staple cartridge.
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7. Insert the staple cartridge. Press down on the top 
of the staple cartridge until it clicks into place.

 

8. Close the front left door.  
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Clear jams in the booklet maker accessory
● Clear jams in the front left door of the booklet maker

● Clear connection jams

● Clear Staple 1 jams

● Clear staple jams in the booklet maker

Clear jams in the front left door of the booklet maker

1. Open the front left door.  

2. Move the lower jam-release lever to the right, and 
then remove any paper.

 

3. Move the lower jam-release handle to the left.  
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4. Move the upper jam-release handle to the right, 
and then remove any paper.

 

5. Move the upper jam-release handle to the left.  

6. Open the lower booklet door.  

7. Turn the lower jam-release knob counter-
clockwise.
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8. Press the jam-release knob, and then turn it 
clockwise.

 

9. Remove all paper from the lower booklet door 
area, and then close the door.

 

10. Close the front left door.  
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Clear connection jams

1. Pull the release handle on the top of the finishing 
accessory, and then slide the finisher away from 
the product until it stops.

 

2. Remove any paper from the area.  

3. Attach the finishing accessory.  
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Clear Staple 1 jams

1. Lift the jam access cover for the output slot, and 
gently remove any jammed paper.

 

2. Wait three seconds, and then open the front left 
door.

 

3. Pull the staple cartridge up and out to remove it.  
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4. Lift up the metal handle on the front of the staple 
cartridge.

 

5. Remove any jammed staples from the staple 
cartridge.

 

6. Push down the metal handle on the front of the 
staple cartridge.
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7. Insert the staple cartridge. Press down on the top 
of the staple cartridge until it clicks into place.

 

8. Close the front left door.  
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Clear staple jams in the booklet maker

1. Open the front left door.  

2. Move the lower delivery guide handle to the right, 
and then remove any paper.

 

3. Move the lower delivery guide handle to the left.  

4. Grasp the green handle and pull the staple carriage 
out.
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5. Pull the green handle of the stapler unit toward 
you and rotate it upward. Push the handle in to lock 
it in the open position.

 

1

2

6. Grasp the edges of each staple cartridge and firmly 
pull up to remove the staple cartridges from the 
staple cartridge unit.

 

7. Press down on the jam-release at the back of the 
saddle-staple cartridge, push up on the plate at the 
front of the cartridge, and then remove any 
jammed staples.

 

1

2
3
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8. Press down on the front of the saddle-staple 
cartridge close it.

 

9. Insert the staple cartridges.  

10. Pull the handle of the staple cartridge unit toward 
you and rotate it downward to its original position. 
Lock it into position by pushing in the handle.

 

1

2
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11. Push the saddle-stitch carriage in.

NOTE: If the saddle-stitch carriage does not 
easily slide into the finisher, the staple unit is not 
closed properly. Pull the saddle-stitch carriage out 
of the finisher and reseat the stapler unit.

 

12. Close the front left door.  
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Improve print quality
● Print from a different software program

● Check the paper-type setting for the print job

● Check toner-cartridge status

● Print a cleaning page

● Visually inspect the toner-cartridge

● Check paper and the printing environment

● Check the EconoMode settings

● Try a different print driver

● Set the individual tray alignment

Print from a different software program
Try printing from a different software program. If the page prints correctly, the problem is with the software 
program from which you were printing.

Check the paper-type setting for the print job
Check the paper type setting if you are printing from a software program and the pages have any of these 
problems:

● smeared print

● fuzzy print

● dark print

● curled paper

● scattered dots of toner

● loose toner

● small areas of missing toner

Check the paper type setting (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper Type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper.
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7. Select the option for the type of paper you are using, and click the OK button.

8. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button 
to print the job.

Check the paper type setting (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then 
click the Finishing menu.

4. Select a type from the Media Type drop-down list.

5. Click the Print button.

Check toner-cartridge status
Follow these steps to check the estimated life remaining in the toner cartridges and if applicable, the status of 
other replaceable maintenance parts.

1. From the Home screen on the product control panel, scroll to and touch the Supplies button.

2. The status of all supply items is listed on the screen.

3. To print or view a report of the status of all supply items, including the genuine HP part number for 
reordering the supply, touch the Manage Supplies button. Touch the Supplies Status button, and then touch 
either the Print or View button.

4. Check the percent of life remaining for the toner cartridges and if applicable, the status of other replaceable 
maintenance parts.

Print quality problems can occur when using a toner cartridge that is at its estimated end of life. The 
supplies status page indicates when a supply level is very low. After an HP supply has reached the very low 
threshold, HP’s premium protection warranty on that supply has ended.

The toner cartridge does not need to be replaced now unless the print quality is no longer acceptable. 
Consider having a replacement available to install when print quality is no longer acceptable.

If you determine that you need to replace a toner cartridge or other replaceable maintenance parts, the 
supplies status page lists the genuine HP part numbers.

5. Check to see if you are using a genuine HP cartridge.

A genuine HP toner cartridge has the words “HP” on it, or has the HP logo on it. For more information on 
identifying HP cartridges go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP cannot recommend the use of non-HP supplies, either new or remanufactured. Because they are not HP 
products, HP cannot influence their design or control their quality. If you are using a refilled or 
remanufactured toner cartridge and are not satisfied with the print quality, replace the toner cartridge with 
a genuine HP toner cartridge.
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Print a cleaning page
Print a cleaning page to remove dust and excess toner from the fuser if you are having any of the following 
problems:

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

Use the following procedure to print a cleaning page.

1. From the Home screen on the product control panel, scroll to and touch the Device Maintenance button.

2. Touch Calibration/Cleaning, and then touch Print Cleaning Page to print the page.

3. The cleaning process can take several minutes. When it is finished, discard the printed page.

Visually inspect the toner-cartridge
1. Remove the toner cartridge from the product, and verify that the sealing tape has been removed.

2. Check the memory chip for damage.

3. Examine the surface of the green imaging drum on the toner cartridge.

CAUTION: Do not touch the imaging drum. Fingerprints on the imaging drum can cause print-quality 
problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the toner cartridge.

5. If the imaging drum does not appear to be damaged, rock the toner cartridge gently several times and 
reinstall it. Print a few pages to see if the problem has resolved.

Check paper and the printing environment

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines when 
selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, voids, 
staples, and curled or bent edges.

● Use paper that has not been previously printed on.
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● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use in Inkjet 
printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.

Check the environment

Environmental conditions can directly affect print quality, and they are a common cause for paper-feeding 
problems. Try the following solutions:

● Move the product away from drafty locations, such as air-conditioning vents, or open windows or doors.

● Make sure the product is not exposed to temperatures or humidity outside of product specifications.

● Do not place the product in a confined space, such as a cabinet.

● Place the product on a sturdy, level surface.

● Remove anything that is blocking the vents on the product. The product requires good air flow on all sides, 
including the top.

● Protect the product from airborne debris, dust, steam, grease, or other elements that can leave residue 
inside the product.

Check the EconoMode settings
HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might 
outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer acceptable, 
consider replacing the toner cartridge.

NOTE: This feature is available with the PCL 6 print driver for Windows. If you are not using that driver, you can 
enable the feature by using the Embedded Web Server.

Follow these steps if the entire page is too dark or too light.

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab, and locate the Print Quality area.

4. If the entire page is too dark, use these settings:

● Select the 600 dpi option.

● Select the EconoMode check box to enable it.

If the entire page is too light, use these settings:

● Select the FastRes 1200 option.

● Clear the EconoMode check box to disable it.

5. Click the OK button to close the Document Properties dialog box. In the Print dialog, click the OK button to 
print the job.
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Try a different print driver
Try using a different print driver if you are printing from a software program and the printed pages have 
unexpected lines in graphics, missing text, missing graphics, incorrect formatting, or substituted fonts.

Download any of the following drivers from the HP Web site. Go to www.hp.com/support. Select your country/
region. Click Drivers & Software. Enter the product name, and then select Search.

HP PCL 6 driver ● Provided as the default driver on the product CD. This driver is automatically installed 
unless you select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for most 
users

● Developed to align with the Windows Graphic Device Interface (GDI) for the best speed 
in Windows environments

● Might not be fully compatible with third-party and custom software programs that are 
based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other highly 
graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript flash 
font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the product 
to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single driver for 
use with multiple product models

● Preferred when printing to multiple product models from a mobile Windows computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for most 
users

● Developed to align with Windows Graphic Device Interface (GDI) for best speed in 
Windows environments

● Might not be fully compatible with third-party and custom software programs that are 
based on PCL 5

Set the individual tray alignment
Adjust the alignment for individual trays when text or images are not centered or aligned correctly on the printed 
page.

1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:
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● General Settings

● Print Quality

● Image Registration

3. Select the tray that you want to adjust.

4. Touch the Print Test Page button, and then follow the instructions on the printed pages.

5. Touch the Print Test Page button to verify the results, and then make further adjustments if necessary.

6. When you are satisfied with the results, touch the Save button to save the new settings.
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Solve wired network problems
Check the following items to verify that the product is communicating with the network. Before beginning, print a 
configuration page from the product control panel and locate the product IP address that is listed on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

NOTE: HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating 
systems and not of the HP print drivers. For more information, go to Microsoft at www.microsoft.com.

Poor physical connection
1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity light and 
the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product
1. Open the printer properties and click the Ports tab. Verify that the current IP address for the product is 

selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always print to this 
printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of the IP 
address.

4. If the IP address is correct, delete the product and then add it again.

The computer is unable to communicate with the product
1. Test network communication by pinging the network.
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a. Open a command-line prompt on your computer. For Windows, click Start, click Run, type cmd, and 
then press Enter.

b. Type ping followed by the IP address for your product.

For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in the Ping 
pane.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network settings, 
the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network
HP recommends leaving these settings in automatic mode (the default setting). If you change these settings, you 
must also change them for your network.

New software programs might be causing compatibility problems
Verify that any new software programs are correctly installed and that they use the correct print driver.

The computer or workstation might be set up incorrectly
1. Check the network drivers, print drivers, and the network redirection settings.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect
1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.

136 Chapter 6   Solve problems ENWW



Index

A
accessories

ordering 30
part number 32

AirPrint 55

B
bins, output

locating 4
Bonjour

identifying 58
booklet maker

delivery guides, locating 12
front door, locating 12
jams 118
output bins, locating 12
part number 32
release latch, locating 12
staple jams 125
stapler, locating 12
top cover, locating 12

booklet makerr
output slot, locating 12

browser requirements
HP embedded Web Server 58

C
cartridge

replacing 33
cleaning

paper path 131
control panel

help 69
locating 4
locating features 8

covers
locating 4

D
deleting

stored jobs 53
document feeder

paper-feeding problems 72
double-sided printing

Mac 48
duplex printing

Mac 48
duplex printing (double-sided)

settings (Windows) 39
duplexer

jams 90
locating 6

duplexing
manually (Mac) 48
manually (Windows) 41

E
easy-access USB printing 56
Embedded Web Server (EWS)

assigning passwords 64
features 58
network connection 58

energy use, optimizing 62
envelopes

loading in Tray 1 17
orientation 19

Ethernet (RJ-45)
locating 7

Explorer, versions supported
HP Embedded Web Server 58

F
FIH (foreign interface harness)

locating 7
file upload, Mac 59
firmware

update, Mac 60

fonts
upload, Mac 59

foreign interface harness (FIH)
locating 7

formatter
locating 6

front door
jams 75
locating 4

fuser
jams 95
locating 6

H
hard disks

encrypted 65
hardware integration pocket (HIP)

locating 4
Help button

locating 8
help, control panel 69
Hi-Speed USB 2.0 printing port

locating 7
HIP (hardware integration pocket)

locating 4
hole punch

setting default location 27
hole punch accessory

connection jams 111
jams 107

Home button
locating 8

HP Embedded Web Server (EWS)
features 58
network connection 58

HP ePrint 54
HP ePrint software 54
HP Utility 59

ENWW Index 137



HP Utility for Mac
Bonjour 59
features 59

HP Utility, Mac 59
HP Web Jetadmin 61

I
imaging drum

locating 33
interface ports

locating 7
Internet Explorer, versions supported

HP Embedded Web Server 58
IP Security 64
IPsec 64

J
jams

auto-navigation 74
booklet maker 118
causes of 74
duplexer 90
front door 75
hole punch accessory 107
hole punch accessory connection

111
left door (fuser area) 95
output bin 99
right door 81
staple in hole punch accessory

104, 115, 122
stapler/stacker 101, 103, 121
staples in booklet maker 125
Tray 1 78
Tray 2 and Tray 3 84
Tray 4 and Tray 5 86

Jetadmin, HP Web 61
jobs, stored

creating (Windows) 50
deleting 53
Mac settings 52
printing 53

L
labels

printing (Windows) 45
LAN port

locating 7
Language Selection button

locating 8

left door
jams 95
locating 6

loading
paper in Tray 1 17
paper in Tray 2 and Tray 3 21
paper in Tray 4 and Tray 5 25

local area network (LAN)
locating 7

M
Mac driver settings

Job Storage 52
Macintosh

HP Utility 59
maintenance kits

part numbers 30
manual duplex

Mac 48
Windows 41

memory
included 2

memory chip (toner)
locating 33

mobile printing solutions 2
model number

locating 6
multiple pages per sheet

printing (Mac) 49
printing (Windows) 43

N
Netscape Navigator, versions 

supported
HP embedded Web Server 58

Network button
locating 8

networks
HP Web Jetadmin 61
supported 2

O
on/off button

locating 4
online help, control panel 69
operating systems (OS)

supported 2
ordering

supplies and accessories 30
OS (operating system)

supported 2

output bin
jams 99

output bins
locating 4

P
pages per minute 2
pages per sheet

selecting (Mac) 49
selecting (Windows) 43

paper
jams 74
loading Tray 1 17
loading Tray 2 and Tray 3 21
selecting 131
Tray 1 orientation 19
Tray 2 and Tray 3 orientation 23
Tray 4 and Tray 5 25

paper jams
booklet maker 118
duplexer 90
front door 75
fuser 95
hole punch accessory 107
hole punch accessory connection

111
output bin 99
right door 81
stapler/stacker 101, 103, 121
Tray 1 78
Tray 2 and Tray 3 84
Tray 4 and Tray 5 86

paper pickup problems
solving 72

paper types
selecting (Mac) 49
selecting (Windows) 45

paper, ordering 30
part numbers

accessories 32
replacement parts 30
staple cartridges 30
supplies 30
toner cartridge 30

ports
locating 7

power connection
locating 6

power switch
locating 4

138 Index ENWW



print media
loading in Tray 1 17

print on both sides
Mac 48
Windows 41

printing
from USB storage accessories 56
stored jobs 53

printing on both sides
settings (Windows) 39

R
Refresh button

locating 8
replacement parts

part numbers 30
replacing

toner cartridge 33
restore factory settings 68
right door

jams 81
locating 4

RJ-45 port
locating 7

S
security

encrypted hard disk 65
serial number

locating 6
settings

restore factory 68
Sign in

control panel 64
Sign In button

locating 8
Sign Out button

locating 8
Sleep button

locating 8
software

HP Utility 59
special paper

printing (Windows) 45
speed, optimizing 62
stacker

staple jams 104, 115, 122
staple cartridges

part numbers 30

staple jams
booklet maker 125
stapler/stacker 104, 115, 122

stapler
locating 10
setting default staple location 27

stapler/stacker
front door, locating 10
jams 101, 103, 121
output bins, locating 10
output slot, locating 10
part number 32
release latch, locating 10
staple jams 104, 115, 122
top cover, locating 10

stapler/stacker with hole punch
front door, locating 11
hole punch, locating 11
output bins, locating 11
output slot, locating 11
release latch, locating 11
stapler, locating 11
top cover, locating 11

stapling
setting default location 27

Start button
locating 8

status
HP Utility, Mac 59

status of product 8
Stop button

locating 8
storage, job

Mac settings 52
stored jobs

creating (Mac) 52
creating (Windows) 50
deleting 53
printing 53

storing jobs
with Windows 50

supplies
low threshold settings 70
ordering 30
part numbers 30
replacing toner cartridge 33
status, viewing with HP Utility for 

Mac 59
using when low 70

supplies status 130

system requirements
HP Embedded Web Server 58

T
toner cartridge

components 33
low threshold settings 70
part numbers 30
replacing 33
using when low 70

toner-cartridge status 130
transparencies

printing (Windows) 45
Tray 1

jams 78
locating 4
paper orientation 19

Tray 2 and Tray 3
jams 84
loading 21
locating 4
paper orientation 23

Tray 4 and Tray 5
clear jams 86
loading 25
locating 4

trays
capacity 2
configure 16
included 2
locating 4

troubleshooting
jams 74
network problems 135
paper feed problems 72
wired network 135

two-sided printing
settings (Windows) 39

U
USB port

enabling 56
locating 7

USB storage accessories
printing from 56

W
Web browser requirements

HP Embedded Web Server 58

ENWW Index 139



Web sites
HP Web Jetadmin, downloading

61

140 Index ENWW


	Product introduction
	Product comparison
	Product views
	Product front view
	Product back view
	Interface ports
	Control-panel view

	Finishing accessory views
	Stapler/stacker
	Stapler/stacker with hole punch
	Booklet maker

	Product hardware setup and software installation

	Paper trays
	Configure trays for paper type and size
	Configure a tray when loading paper
	Configure a tray to match print job settings
	Configure a tray by using the control panel

	Load Tray 1
	Load Tray 2 and Tray 3
	Load Tray 4 and Tray 5
	Configure the default staple location
	Configure the default hole punch location

	Parts, supplies, and accessories
	Order parts, accessories, and supplies
	Ordering
	Parts and supplies
	Accessories

	Replace the toner cartridge

	Print
	Print tasks (Windows)
	How to print (Windows)
	Automatically print on both sides (Windows)
	Manually print on both sides (Windows)
	Print multiple pages per sheet (Windows)
	Select the paper type (Windows)

	Print tasks (Mac OS X)
	How to print (Mac OS X)
	Automatically print on both sides (Mac OS X)
	Manually print on both sides (Mac OS X)
	Print multiple pages per sheet (Mac OS X)
	Select the paper type (Mac OS X)

	Store print jobs on the product
	Create a stored job (Windows)
	Create a stored job (Mac OS X)
	Print a stored job
	Delete a stored job

	Mobile printing
	HP ePrint
	HP ePrint software
	AirPrint

	Print from the USB port
	Enable the USB port for printing
	Print USB documents


	Manage the product
	HP Embedded Web Server
	How to access the HP Embedded Web Server (EWS)

	HP Utility for Mac OS X
	Open HP Utility
	HP Utility features

	Use HP Web Jetadmin software
	Economy settings
	Print with EconoMode
	Set Sleep mode
	Set the Sleep Schedule

	Product security features
	Security statements
	IP Security
	Sign in to the product
	Assign a system password
	Encryption support: HP High Performance Secure Hard Disks

	Software and firmware updates

	Solve problems
	Restore factory-set defaults
	Control panel help system
	A “Cartridge is low” or “Cartridge is very low” message displays on the printer control panel
	Change the “Very Low” settings
	For products with fax capability

	Order supplies

	Product does not pick up paper or misfeeds
	The product does not pick up paper
	The product picks up multiple sheets of paper
	The document feeder jams, skews, or picks up multiple sheets of paper

	Clear jams
	Auto-navigation for clearing jams
	Experiencing frequent or recurring paper jams?
	Clear jams in the front door
	Clear jams in Tray 1
	Clear jams in the right door
	Clear jams in Tray 2 and Tray 3
	Clear jams in Tray 4 and Tray 5
	Clear jams in the duplexer
	Clear jams in the left door (fuser area)
	Clear jams in the output bin area
	Clear jams in the stapler/stacker accessory
	Clear jams in the stapler/stacker
	Clear connection jams
	Clear Staple 1 jams

	Clear jams in the stapler/stacker with hole punch accessory
	Clear top left door jams in the stapler/stacker with hole punch accessory
	Clear a connection jam in the stapler/stacker with hole punch accessory
	Clear Staple 1 jams

	Clear jams in the booklet maker accessory
	Clear jams in the front left door of the booklet maker
	Clear connection jams
	Clear Staple 1 jams
	Clear staple jams in the booklet maker


	Improve print quality
	Print from a different software program
	Check the paper-type setting for the print job
	Check the paper type setting (Windows)
	Check the paper type setting (Mac OS X)

	Check toner-cartridge status
	Print a cleaning page
	Visually inspect the toner-cartridge
	Check paper and the printing environment
	Use paper that meets HP specifications
	Check the environment

	Check the EconoMode settings
	Try a different print driver
	Set the individual tray alignment

	Solve wired network problems
	Poor physical connection
	The computer is using the incorrect IP address for the product
	The computer is unable to communicate with the product
	The product is using incorrect link and duplex settings for the network
	New software programs might be causing compatibility problems
	The computer or workstation might be set up incorrectly
	The product is disabled, or other network settings are incorrect


	Index

